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Labs

17.10

24 .10

31.10 Introduction to Unity (roll-a-ball)
Roll-a-ball in VR

07.11 VR parkour

14.11 Pitch your locomotion and interaction idea

21.11 Reverse classroom 1

27.11 Reverse classroom 2



Reverse classroom topics

First name

Choice

Sebastian Rudolf

Lea Sophie
Michael
Elif

Frank
Nadine
Chen
Hanjo
Karolis
Alexander
Jonas
Austin
Luis

Dillon

Flavian

Animations in Unity3D
How To Grab Objects With Hands In VR - Oculus Interaction SDK

How to jump in Unity (with or without physics)

How to move objects in Unity (3 methods)

How to setup Meta Avatar in Unity - VR Tutorial

How to use Cameras in Unity: Cinemachine Overview and Brain Explained!
Introduction to VR in Unity - PART 9 : CLIMBING

Inverse kinematics

Meta Quest Passthrough Tutorial in Unity - PART 2 : Styling

Tunnelling Vignette against Motion Sickness

Unity Shader Graph (Trails)

Unity VR Game Basics - PART 7 - Continuous Movement

Writing Your First Shader In Godot

3% copor
Writing Your First Shader In Godot ~ Sells# Comecnone

?



Pick up your Meta Quest

31.10 Tue. 14-16h
01.11 Wed. 9-12h, 13-16h
02.11 Thur. 9-12h, 13-16h

Come to A307, S2|02, to pick up your Quest 2!
If you could not make it, please contact

wen-jie.tseng@tu-darmstadt.de or
willich@tk.tu-darmstadt.de



mailto:wen-jie.tseng@tu-darmstadt.de
mailto:willich@tk.tu-darmstadt.de

basics of Unity



Create a new 3D project from UnityHub

Go to Projects tab > press NEW to create a new project

= All templates Q

“— 17 2D

9 P

o 2D (URP)

ISRP 3D (HDRP)

(SRP) Dbl testingTutorial

SRP 3D Sample Scene (HDRP) D:\unity-projects

Cancel Create project




() testingTutorial - SampleScene - Windows, Mac, Linux - Unity 2021.3.10f1 Personal <DX11>

File Edit Assets GameObject Component Window Help

OWi~Y & ® | | B % O, Layers v layout v
#t Scene ! o®Game i = Hierarchy 3 { @ Inspector =)
v R~ v i i v Qv 20 ¢ 6 v ¢ mv GCame v Display 1 ¥ Full HD (1920x1080) ¥ Scale @ 0.35x Play Focused + ¥ « 2
T ———————— P SampleScene H
W > = &0 Main Camera
€0 Directional Light
(-:-v e X
®) ®
-t <Persp
N
B Console : mProject =]
Clear ¥ Collapse Error Pause Editor ¥ Q 0 0o @o +~v o 7 & € P16
aw Assets
Im Scenes
s Packages

Then you have a new unity project
to play around!




() testingTutorial - SampleScene - Windows, Mac, Linux - Unity 2021.3.10f1 Personal <DX11>

File Edit Assets GameObject Component Window Help

OWr~y & ® O | I 2 9 O, Layers v Layout v
fi# Scene ! oa®Game i = Hierarchy 2 { @ Inspector g i
@ v @ v m v {i i v Qv [ ] 6 v ¢ mv GCame v Display 1 ¥ Full HD (1920x1080) ¥ Scale @ 0.35x Play Focused + v « )
Y — —— | P SampleScene :
W y - ) Main Camera
& Directional Light
(-I-) ’ X
®) ®
- <Persp .
-—n L ]
@
5 hierarchy t
— o INSpectlor
B Console : mProject 8 i
Clear ¥ Collapse Error Pause Editor ¥ Q 0 0 @0 +~ o 7 & € 16
aw Assets
I Scenes
s Packages

console project
window




Scene navigation

select orbit
Flythrough mode

drag (on pressed) Right click +  WASD EQ

——_
L

zoom (on scroll)




Transform

 The GameObject has Components that determine their behavior

« All objects have the Transform component to determine the object’s

 Position
 Rotation
3 ¥ .~  Transform @
¢ Scale Position X [0 y 0 z0
Rotation X 0 Y 0 Z0
Scale X1 Y1 Z'1




M ¢+ EIEIRIKIES

Coordinate system

« Change position, rotation, scales

in the scene view




NIK3 S EAiRIOIES © Glob:

H: Scene

Rotation S

« Can be expressed in EulerAngles (x, vy, z)

« Positive and negative rotation using left
hand coordinate

* Rotates the GameObject’s local axis

Positive (+)
rotation




O 4 | S P

#: Scene

Scale shaded AR

« Scale > 1: increase the size of an object

« Scale < 1: reduce the size of an object




v € SampleScene*
 Directional Light

Parent — Child VNS Crtder e Child

~ Main Camera as Child

* The transform of the child is relative to the parent’s

 For example:
« Character carries the Camera
« GameObject made of many GameObjects

« Grouping things together

« To remove this relationship, just drag child out of the hierarchy of parent.



unity roll a ball



Online resources

« There are many materials ranging from the beginner to advance on

« Unity projects (https://learn.unity.com/projects)

 Unity tutorial (https://learn.unity.com/tutorials)
* GitHub, YouTube, etc.



https://learn.unity.com/projects
https://learn.unity.com/tutorials

Some projects to start with

* Roll-a-Ball (https://learn.unity.com/project/roll-a-ball?uv=2019.4)

~ — — ° ° .
Y Roll-a-Ball .= Survival Shooter Training Day Phases
Q ‘D % Project = Beginner = 2 Hours 10 Mins » {404 E:{ ‘Q /=———— Tutorial » Beginner + 3 Hours 30 Mins * R115
< | Unity Technologies .:-"--.‘?;7 ‘; €  Unity Technologies
Overview Overview T}
Your progress Summary Your progress Summary Language
Welcome to Roll-a-ball! In this learning project, you ollow along in the development of the Survival Shooter project from setting up the English
ironment all the way t« eating a Game O r
J ° E 1 its buil 1

Select your Unity versione

@ Create a basic user interface to improve the game experience 4. Creating Enemy #1 Last updated: September 10, 2020



https://learn.unity.com/project/roll-a-ball?uv=2019.4

Count: O

| 1

: L ‘
' ’
L

| |
= 1‘——-1




The goal of the game:

 when Player hits a , the disappears
and increase the score.

* |f score > X, win.



create a new Scene

« Assets > create > scene

« Use project window

20-unity-roll-a-ball - SampleScene - PC, Mac & Linux Standalone - Unity 2019.4.3f1 P

Assets GameObject Component Tutorial

Window Help

Show in Explorer
Open

. Delete

Rename

Copy Path
Open Scene Additive
View in Package Manager

Import New Asset...
Import Package

Export Package...

Find References In Scene
Select Dependencies

Refresh
Reimport

Reimport All

Alt+Ctrl+C

Ctrl+R

Folder

C# Script

Shader

Testing

Playables

Assembly Definition
Assembly Definition Refer
TextMeshPro

Volume Profile
Prefab Variant

Audio Mixer
Rendering

Material
Lens Flare
Render Texture

linhtman Parameterc



1 - BINEEIES E ﬂIIl

= Hierarchy #t Scene

R — lmlnm-m Display 1 - Free Aspect ____~ Scale @ 1x__ Maximize OnPlay b

v €{ New Scene
() Main Camera
(1) Directional Light

-R




rename New Scene

* right click the Scene you created

In the Project panel

select the Rename

Create >
Show in Explorer

Open

Delete

Copy Path Alt+Ctrl+C
Open Scene Additive
View in Package Manager

Import New Asset...

Import Package >
Export Package...

Find References In Scene

Select Dependencies

Refresh Ctrl+R
Reimport

Reimport All
Extract From Prefab

Run APl Updater...

Update UlElements Schema
Open C# Project




create a ground

ity-roll-a-ball - roll-a-ball - PC, Mac & Linux Standalone - Unity 2019.4.3f1 Personal <DX11>
2ts GameObject Component Tutorial Window Help

. . 5 Create Empty Ctrl+Shift+N
° GameObJect > 3D ObjeCt > Plane Create Empty Child Alt+Shift+N
= 3D Object > Cube
:l 2D Object > Sphere
‘aT‘ Effects > Capsule
irec Light > Cylinder
Audio > Plane
Video > Quad
4 ? Text - TextMeshPro
Volume > Raadll
Camera 22 ElE
Center On Children Terrain
Tree
Clear Parent
A | 3D Text
v € roll-a-ball* : Set as first sibling Ctrl+=

(1) Main Camera Set as last sibling Ctrl+-
(7] Directional Light Move To View Ctrl+Alt+F
fp) Plane Align With View Ctrl+Shift+F

Align View to Selected

Toggle Active State Alt+Shift+A




= Hierarchy

+ v oAl

v < New Scene

f{) Main Camera
f{) Directional Light
(1) Ground

# Scene ‘

SSet Slore o Game
il ¢ = o0 5 |- R RES cizmos v [[ca ] m
y =




rename the Plane

B} vAR2020-unity-roll-a-ball - roll-a-bal
File Edit Assets GameObject Comg

* right click it in the hierarchy /

In the inspector

v € roll-a-ball*




set Ground at (0,0,0)

 Inspector > Transform

Tag Untagged v

Move to Front
Move to Back
Copy Component

Paste Component As New
Paste Component Values

Find References In Scene
Reset Position
u Reset Rotation

c Reset Scale




Change scale to (2,1,2)

« Use inspector

Tag Untagged v Layer Defaull
Transforn

0 Yo [zo
n n n




Directional Light
Transform

Light

Ground

Transform

Main Camera Renderer
Transform Collider

Camera



Directional Light
ag Untagged

In the Directional Light

* Adjust Transform

Directional

I

4

Realtime

Soft Shadows

Use Quality Settings

1

1
T
005
04
02

(O]

None (Texture)

IS

None (Flare)
Auto
Everything

Add Component



¥ Inspectol

Directional Light Stz

Tag Untagged v LayerDefaut  +

In the Directional Light

* Adjust Transform

« Change the color of light to white

None (Texture)
10

None (Flare)
Auto
Everything

828282

Add Component



create Materials

In Assets > Create > Material

_ ject | E Console

+ -

¥ . avorites
O, All Materials
<, All Models
O, All Prefabs

r @@ Assets
= Input
s Materials
I Prefabs
s Scenes
= Scripts
> s Template
> Bm TextMesh Pro
~ m Packages

Assets > Materials

cl1ejelelc

Background pick-up

s Assets/Materials

Player

White 1

White

Create

Show in Explorer
Open

Delete

Rename

Copy Path

Open Scene Additive
View in Package Manager

Import New Asset...
Import Package

Export Package...

Find References In Scene
Select Dependencies

Refresh
Reimport

Reimport All

Extract From Prefab

Run APl Updater...

Update UlElements Schema
Open C# Project

Alt+Ctrl+C

Ctrl+R

Folder

C# Script

Shader

Testing

Playables

Assembly Definition

Assembly Definition Reference
TextMeshPro

Scene

Volume Profile
Prefab Variant
Audio Mixer

Rendering

Material

Lens Flare

Render Texture
Lightmap Parameters
Custom Render Texture

Sprite Atlas

Sprites

Animator Controller
Animation

Animator Override Controller
Avatar Mask

Timeline

Signal

Physic Material
Physics Material 2D

GUI Skin
Custom Font
UlElements

Legacy
Brush




1 nspecitol
o
>nadel Standard

change Color

 Select the Material

« Change color in the Inspector

—828282




change Color

# Scene | i | awGame | : = Hierarchy

shaced 0 & W% |~ %0 fy ~ XM~ omos - |Free spect - Scale @ 1 Maxmize onPiay wute Al 4+ <
y

v € New Scene
o ) Main Camera
() Directional Light

” * () Ground

Drag the Materials onto the Ground
In the Scene panel

s Project
+ v VO\ - =t

v (@ Assets
> Bm inputactions
v @ Materials
Q Blue
QD Green
® Ground
Picku
£ Console 8 p|aye$

CIearlCoIIapse Clear on Play | Clear on Build | Error Pause | Editor v Q | Qo A0|©O Q Red
| QD wall




change Color e .

ag Untagged v ayer Default

al ’ ‘
v B h Rendere

* You can also drag into the

inspector of the gameobject.

_ Q Default-Material O

|

Blend Probes
Blend Probes
None (Transform)

Per Object Motion v




# Scene

Shaded v 20| @ W ||~ 0 £y |v| K W v Gizmos | v,
y .

»"‘




Directional Light
Transform

Light

Ground

Transform

Main Camera Renderer
Transform Collider

Camera



Directional Light
Transform

Light

Ground

Transform
Main Camera Renderer
Transform Collider

Camera



Create a sphere

n VAR2020-unity-roll-a-ball - roll-a-ball - PC, Mac & Linux Standalone
File Edit Assets GameObject Component Tutorial Window He

234 - FEIES

 Resetto (0, 0, 0)

“= Hierarchy # Scene Asset Store
+ v oAl | Shaded v |m| e
. 73 " ' :
¢ Name |t aS Player Create Empty :
Create Empty Child |7
3D Object > Cube
2D Object > Sphere
Effects > Capsule
Light > Cylinder
Audio > Plane
Video > Quad
ul > Text - TextMeshPro
Volume > Ragdoll...
Camera Terrain
Tree
Wind Zone

3D Text



Create a sphere

# Scene

=[] ¢ W[ |v| 0/ |~ X |8~ Gizmos |~
y

« The player is in the Plane...




adjust Transform

# Scene @ Game ‘= Hierarchy

v <) New Scene H

- m | ¢ W< |~ %0 & |- K W~ cizmos ~|Free Aspect T Ty R —
y =l

) Main Camera

. ) Directional Light
gy ) Ground
- &0 Player

s Project

+v _’k & € | #9

O Inspector

@ v Player || staticv
¥ Fanl Lintacaad v laver Default v ‘

v ).  Transform o

v @ Assets
» B inputactions
v @ Materials
Q Blue
9 Green

q Position X 0 Y05

'Zo

change transform / y to 0.5

¥ Materials
Size 1 |
Element 0 Q@ Default-Material )
¥ Lighting
Cast Shadows On v
Receive Shadows v
Contribute Global lllui
Receive Global lllumi Light Probes v
¥ Probes
Light Probes 'Blend Probes v
Reflection Probes  Blend Probes v
Annhnar Ouarrida N ol



adjust Transform ST e Tle 1= ol |- 3¢ Jarcimos -

« Create a new color for Player




Directional Light
Transform

Light

Ground

Transform
Main Camera Renderer
Transform Collider

Camera



Directional Light
Transform

Light

Ground

_ Player Transform
Main Camera Transform Renderer
Transform Rend Collider
Camera enderer

Collider



Renderer
Rigidbody

GameObject

A GameOQObiject has many components.
They all can be attached or removed in Unity or by script.



PlayerController.cs

We can also use scripts as
a Component to control
the GameQObiject.

Renderer

GameObject

Rigidbody




Components

 Add Component: « Remove Component:
@ nspector LGNS © Inspector  [IINEEE

¥ [Empty Game Object | [ ] Static ¥ . ¥ [Sphere | [L] static ¥
Tag [Untagged  :] Layer [Default ¢ Tag (Untagged  ¢] Layer [Default  +]

Move to Front

‘ Move to Back

C Move Up

Move Down

Copy Component

Paste Component As New

Paste Component Values



Add Component

« Select Rigidbody:
* physics

« detecting collision or trigger

Blend Probes
Blend Probes
None (Transform)

Search




Create a new script PlayerController.cs

FOTspec-tor_]-_-_-_MT
« Add Component > type PlayerController |g - e Static +

- Tag Untagged v Layer Default v
> NeW Scnpt v ). Transform @ 3t

Position X0 Y 0.5 Z0

Rotation X0 Y 0 Z0

Scale X1 Y 1 Z1

T+

» B Sphere (Mesh Filter)
» B v Mesh Renderer

» @ v Sphere Collider

» &  Rigidbody

> ¢ v Player Input

. Player (2 Rl o
Shader Universal Render Pipeline/Lit v

Add Component

(@ PlayerController x]
# Search

T+

T+ | 1

O OO O ®
T+

T+

>

Assets

Input Materials Scenes Scripts Template PlayerCont...




Directional Light
Transform

Light

Ground

_ Player Transform
Main Camera Transform Renc!erer
Transform Renderer Collider

Camera Collider
Rigidbody
Playerinput

[PlayerGontroller.cs]



Double click PlayerController.cs

C¢ PlayerController.cs X

Assets > Scripts > C# PlayerController.cs > % PlayerController

2

using UnityEngine;
*

0 references
public class PlayerController

{

MonoBehaviour

0 references
void Start()

{

0 references
void Update()
{

Edit Assets GameObject Component Tutorial Window Help

Undo Selection Change
Redo

Select All

Deselect All

Select Children

Select Prefab Root
Invert Selection

Cut

Copy
Paste
Duplicate
Rename
Delete

Frame Selected

Lock View to Selected
Find

Play

Pause

Step

Sign in...

Sign out

Project Settings...
Preferences...

Ctrl+Z
Ctrl+Y
Ctrl+A
Shift+D
Shift+C
Ctrl+Shift+R
Ctrl+1

Ctrl+X
Ctrl+C
Ctrl+V

Ctrl+D

F
Shift+F
Ctrl+F
Ctrl+P

Ctrl+Shift+P
Ctrl+Alt+P

R2020-unity-roll-a-ball - roll-a-ball - PC, Mac & Linux Standalone - Unity 2019.4.3f1 Personal* <DX11>

@ Global .

| b

Asset Store

- o a s AR ey

£ Preferences

v (| 2D

General
2D
¥ Analysis
Profiler
Cache Server (global)
Colors
Core Render Pipeline
External Tools
Gl Cache
Shader Graph
Ul Scaling

External Tools

External Script Editor
External Script Editor Aras
Reset argument
Generate .csproj files for:
Embedded packages
Local packages
Registry packages
Git packages
Built-in packages
Local tarball
Packages from unknown sources
Regenerate project files
Extensions handled:
Add .unityproj's to .sln
Editor Attaching

Image application

Revision Control Diff/Merge

No supported VCS diff tools were found. Please install one of the following

Aealo.

—

Visual Studio Code

v

"$(ProiectPath)" -a "$(File)":$(Line):$(Colu

cs;uxml;uss;shader;compute;cginc;hlsl;glsl

v

Open by file extension

v
rem v




Double click PlayerController.cs

PlayerController.cs X

Assets > Scripts > €+ PlayerController.cs > %8 PlayerController

J

using UnityEngine;

class PlayerController : MonoBehaviour

0 references

oid Update()




Legend

User callback )
T TR
[ Internal function )

Awake <

n . -
U n I t L I fe C CI e - Initialization

e itIANIZALIQN.

‘Startis only ever called once for a given script.

. called once at the beginnin

The physics cycle may happen more than once per frame if
the fixed time step s less than the actual frame update time.

Internal animation update [———

OnStateMachineEnter/Exit

- FixedUpdate: for physics (e.g.,

OnAnimatorMove

Internal physics update . u
Phvelcs R|g id bOdy

OnAnimatorlK

T

( VineProperies )

OnTriggerXXX

OnCollisionXxXX. A
1
( yield WaltForFixedUpdate

onbsiK Input events

Update

yield nul T,

ifa i
resume then execution takes
update.

Internal animation update I A4

. we usually put everythin
— e here except physics

OnAnimatorMove

| ProcessAnimation |

( WiiteProperties

LateUpdate

nderObject
OnPrecul

Scene rendering

Gizmo rendering

OnGUI i called multiple time per frame update.

GUI rendering

WJM End of frame

T . ;
e ; ) Pausing

OnAppiicationQuit

v G
nDisal s called only when he scpt was sl du
e . OnEnatie wi b caed s rabld agin. m:w ) Decommissioning

OnDestroy —

el



https://docs.unity3d.com/Manual/ExecutionOrder.html

PlayerController.cs

ing UnityEngine;

1 . SJI()t)Eal \/EifiEit)lEBES >‘i?’iAti PlayerController : MonoBehaviour

2. reference the rigidbody in the script

speed;

Rigidbody rb;

his.GetComponent<Rigidbody>();




PlayerController.cs

« FixedUpdate(): move the Player using .AddForce

id FixedUpdate()

Input.GetAxis("Horizontal");
z = Input.GetAxis("Vertical™);
Vector3 movement = new Vectorid(x, 0, z);
rb.AddForce(movement * speed);




Directional Light
Transform

Light

Ground

_ Player Transform
Main Camera Transform Renc!erer
Transform Renderer Collider

Camera Collider
Rigidbody
Playerinput

[PlayerController.cs]



Directional Light
Transform

Light

Ground

- Player Transform
Tam ?mera Transform Renc!erer
Eaanns;eor;m Renderer Collider

[CameraController.cs] R(i;;iltlillgggy

Playerinput

[PlayerController.cs]



& Collab ¥ Account ¥
© Inspector | 3 i
@ v Main Camera Static v
- Tag MainCamera v  Layer Default v |
v ).  Transform o
Position X0 Y1 Z -10
Rotation X0 YO Z0
Scale X1 Y1 Z1
Y Bt v Camera o
Render Type Base v
> Projection
> Rendering
» Environment
» Output
» Stack
i+ v Audio Listener e =
Y |# Universal Additional Camera Data (Script) o
Add Component
CameraController
< New script

select Main Camera >

create CameraController

Create and Add




layerController.cs ** CameraController.cs X Release Notes: 1.49.1

Assets > Scripts > € CameraController.cs > %2 CameraController

CameraController.cs | A

using 1tyEngine;
using UnityEngine;

; CameraController : MonoBehaviour

2 references
GameObject player;

2 references

® opriva Vector3 offset;

) references

Start()

offset = transform.position - player.transform.position;

) references

LateUpdate()

transform.position = player.transform.position + offset;




Inspector of Main Camera

1. Adjust the Transform for viewing
angle of the game.
2. Drag the Player GameObject in the

reference of CameraController.cs

© Inspector

@ v Main Camera

Tag MainCamera v Layer Default
1_J oo Transform e
Position X0 Y 10 Z -10
Rotation X 45 Y O Z 0
Scale X1 Y 1 2 1
Y Wt v Camera 0
Render Type Base
» Projection
» Rendering
» Environment
» Output
b Stack
v Audio Listener 0
Y # Universal Additional Camera Data (Script) o
% « Camera Controller (Script) 0

Script CameraController

Player (0 Player




Wall Directional Light
Transform Transform

Child: Wall * 4 Light

O

Ground
o Player Transform
]e_un ?mera Transform Rend_erer
Eaanns;eor;m Renderer Collider
Collider
[CameraController.cs] Rigidbody
Playerlnput

[PlayerController.cs]



create Empty GameObject

« We use empty GO to collect things
together (e.g., walls, environment).
« Therefore, you can manipulate them

all at the same time.

o ol Q@ All

Snaaea

v € roll-a-ball*

1) Main Camera

[) Directional Light
{1 Ground

(11 Player

B oAl

Copy
Paste

Rename
Duplicate
Delete

Select Children
Select Prefab Root

Create Empty
3D Object
2D Object
Effects

Light

Audio

Video

Ul

Volume

NGNS NN NN NN

Camera



O Inspector | 2

= Hierarchy | 3 i | # Scene | @ Asset Store i | @ v Wall Static v |
+v oAl Shaded v||2D0 || @ | (& |v B0 || v| K - Tag Untagge(
- quh;:i-nbg:mera : v /.  Transform Wal I pa ram ete 'S
%giﬁzg’"a' Light Position X -10 Y 0 Z 0
B Rotation X 0 Y 0 Z 0
v ®$§'~"‘:" g Scale X 0.5 Y 2 Z 20.5
%az:: ?2)) » B8 Cube (Mesh Filter) 0
) Wall (3) » B v Mesh Renderer o
v &¥ v Box Collider @ 3 !
Edit Collider oY
Is Trigger I
Material None (Physic Material) ®
Center X 0 YO Z0
Size X 1 Y1 Z1
White (7 i o
Shader Universal Render Pipeline/Lit v




Wall Directional Light
Transform Transform

Child: Wall * 4 Light

Pick-up
Transform

Renderer
Collider

O

Ground
o Player Transform
Taun ?mera Transform Rend_erer
Eaanns;eorram Renderer Collider
Collider
[CameraController.cs] Rigidbody
Playerlnput

[PlayerController.cs]



The pick-up

» Create a cube and name as pick-up

« Change Transform

* Create a material for the pick-up

Universal Render Pipeline/Lit




= Hierarchy |

Select Y to change the

7 v < roll-a-ball

£7) Main Camera "

S perspective to the top >

(1) Ground

1) Player - =

, DPlare Ctrl-D / cmd-D
v (1) Pickups .

% Pick-up duplicate and arrange
&P Pick-up (1)
&P Pick-up (2)
&P Pick-up (3)
&P Pick-up (4)
&P Pick-up (5)
&P Pick-up (6)
WP Pick-up (7)
WP Pick-up (8)
WP Pick-up (9)
W9 Pick-up (10)
WP Pick-up (11)
WP Pick-up (12)
WP Pick-up (13)
WP Pick-up (14)
&¥ Pick-up (15)
&¥ Pick-up (16)
WP Pick-up (17)
&% Pick-up (18)

VWV V V V V VVV VYV VYV VYV VYV

¥ | Scale ®— 1x




= Hierarchy | i | # Scene @ Asset Store

4+~ oAl Shaded v Imlnmm Display 1 ~ Free Aspect ¥ Scale @— 1x
v <4 roll-a-ball : 2
» 1) Main Camera ‘
[) Directional Light
(1) Ground i, =
f{) Player ‘
> () Walls .
¥ () Pickups <Top
W9 Pick-up
&P Pick-up (1)
&P Pick-up (2)
&P Pick-up (3)
&P Pick-up (4)
&P Pick-up (5)
&P Pick-up (6)
WP Pick-up (7)
WP Pick-up (8)
WP Pick-up (9)
W9 Pick-up (10)
W9 Pick-up (11)
¥ Pick-up (12)
W@ Pick-up (13)
W9 Pick-up (14)

sl Question: what if | need to change the parameter

WP Pick-up (17)

SESIEEN of pickup? = we use Prefab

VWV V V V VVV VYV VYV VYV




create Prefab

= Hierarchy & i | # Scene | I Asset Store
+ - ar All Shaded v(i(20 | @
v € roll-a-ball*
) Main Camera
) Directional Light
0 Ground
7 Player
» (7 Walls
» () Pickups
» [0 Canvas
) EventSystem
0 Pick-up

W |- Q')O‘fx/ "’.’/

drag the GameObject to
Project Window

M Project & Console

+ -
v - Favorites | Assets

O, All Materials

O, All Models N

S mmambh
v @ Assets \

B Input Input Materials Prefabs Scenes Scripts Template TextMesh ...

B Materials



create Prefab

 The GameOQObiject in hierarchy turns blue.

= Hierarchy

+~

ar All

v € roll-a-ball*

B Project B Console

*r | @Pickwp
Pick-u
v  Favorites Assets > Prefabs ﬁ B

O, All Materials

O, All Models
O, All Prefabs
v @ Assets

= Input Pick-up
M Materials
Prefabs

double click the prefab

) Main Camera
(1) Directional Light
) Ground
7 Player

» () Walls

v () Pickups

W9 Pick-up (1)
W9 Pick-up (2)
W9 Pick-up (3)
W9 Pick-up (4)
W9 Pick-up (5)
W9 Pick-up (6)
W9 Pick-up (7)
W9 Pick-up (8)
W9 Pick-up (9)
W9 Pick-up (10)
% Pick-un (11

vvVVVVVVVVYVY

>




Prefab editing mode g5l

Shaded v|[20 ]| @ | 4 IvL@'OH{ﬁ? v ‘klll ¥ | Gizmos | ¥

€ Scenes | W@ Pick-up v| Auto Save

 The changes you made in this
mode will be passing to all the

prefab gameobjects in the scene.




Our goal in this game:

 when Player hits , the disappears
and increase the score.

* |f score > X, win.



Let's have a look in our game

« Unity Colliders

static
(Wall)

Collider . . ]
detect collision:
Add dynamic « OnCollisionEnter()
Rigidbody — (Player, « OnTriggerEnter()
) detect when one collider enters

the space of another without
creating a collision

In our example:
Player has OnTriggerEnter
IS triggered


https://docs.unity3d.com/Manual/CollidersOverview.html

Let's have a look in our game

e Unity Colliders

ctatic static
(Wall) collider
- collider
Add _— (Player
. Rigidbody | 3 _ _
\ ’ kinematics k_m_ematlc
(Transform) rlgldbOdy
collider

|
|
move a kinematic rigidbody object by

modifying its Transform Component but
it will not respond to collisions and forces.


https://docs.unity3d.com/Manual/CollidersOverview.html

Unity Colliders

Collision detection occurs and messages are sent upon collision

Static Rigidbody Kinematic Rigidbody
Collider Collider Collider

Static Collider Y

Rigidbody Collider Y Y Y

Kinematic Rigidbody Collider Y

Static Trigger Collider
Rigidbody Trigger Collider

Kinematic Rigidbody Trigger
Collider

Trigger messages are sent upon collision

Static Rigidbody Kinematic Rigidbody
Collider Collider Collider

Static Collider

Rigidbody Collider

Kinematic Rigidbody Collider

Static Trigger Collider Y Y

Rigidbody Trigger Collider Y Y Y

Kinematic Rigidbody Trigger Y Y Y

Collider

Static Trigger
Collider

Static Trigger
Collider

Rigidbody Trigger
Collider

Rigidbody Trigger
Collider

< < < =< =< <

Kinematic Rigidbody Trigger
Collider

Kinematic Rigidbody Trigger
Collider

< < < < =< <


https://docs.unity3d.com/Manual/CollidersOverview.html

back to PlayerController.cs

e Unity Colliders

D references

OnTriggerEnter(Collider other)

other.gameObject.SetActive(

Trigger messages are sent upon collision

Static Collider

Static Collider
Rigidbody Collider

Kinematic Rigidbody
Collider

Static Trigger Collider
Rigidbody Trigger Collider

Kinematic Rigidbody Y
Trigger Collider

Rigidbody Collider

Player

Kinematic Rigidbody
Collider

Static Trigger Collider

Rigidbody Trigger Collider

Kinematic Rigidbody
Trigger Collider

Y
Y
Y


https://docs.unity3d.com/Manual/CollidersOverview.html

Add tag

 In the inspector of pick-up prefab, select Add tag and add “pickups”.

# Scene @ Asset Store

3 O Inspector 2 i
Shaded v |20 || @ | st |v 950 |5y v ¥ | Wv | Gizmos | v| | |Display1 ¥ |Free Aspect ¥ | Scale ®— 1x @ vIPick-up Static v
-~ =
- s | e v, Auto Save Tag Untagged v Layer Default v
=N T v Untagged e
. Respawn
Position Finish Y 0.5 Z0
Rotation EditorOnly Y 45 Z 45
Scale MainCamera Y 0.5 Z 0.5
Player o
GameControll
ameController o =

id OnTriggerEnter(Collider other)

T*

if (other.gameObject.CompareTag(“pickups”
A

!

other.gameObject.SetActive( i = o



Rotator.cs

s Rotator : MonoBehaviour

0 references
(f‘i Update()
{

transform.Rotate (new Vector3 (15, 30, 45) * Time.deltaTime);

\}




." v | Pick-up Static ¥

v

Tag pickups v  Layer Default -
edit Pick-up prefab v Transtomm o=
Position X0 i 0.5 ZO0
Rotation X 45 Y 45 Z 45
Scale X 0.5 Y 0.5 Z 0.5
 add Rotator.cs » B Cube (Mesh Filter) o
» B v Mesh Renderer 0 +
* In Box Collider component v &  Box Collider o =
Edit Collider oY
» check Is Trigger Is Trigger
Material None (Physic Material) ®
* In Rigidbody component Center Ao o 20
Size X1 Y 1 2 1
« uncheck Use Gravity v& Rigidbody @ =
. . Mass 1
« check Is Kinematic Drag 0
Angular Drag 0.05
Use Gravity
Is Kinematic
Interpolate None -
Collision Detection Discrete -

b Constraints
> Info



Wall Directional Light
Transform Transform

Child: Wall * 4 Light

Pick-up
Transform

Renderer
Collider

O

Ground
o Player Transform
Taun ?mera Transform Rend_erer
Eaanns;eorram Renderer Collider
Collider
[CameraController.cs] Rigidbody
Playerlnput

[PlayerController.cs]



Wall Directional Light
Transform Transform

Child: Wall * 4 Light

Pick-up (prefah)
Transform
Renderer
Collider
Rigidbody
[Rotator.cs]

O

Ground

o Player Transform
]e_un ?mera Transform Rend_erer
Eaanns;eor;m Renderer Collider

Collider

[CameraController.cs] Rigidbody

Playerlnput

[PlayerController.cs]



Wall Directional Light
Transform Transform

Child: Wall * 4 Light

Pick-up (prefab)
Transform
Renderer
Collider
Rigidbody
[Rotator.cs]

RectTransform

TextMeshPro Q Ground
_ Player Transform
Main Camera Transform Rend_erer
Transform Renderer Collider
. Cgmetfa" | Collider
ameraController.cs Rigidbody
Playerlnput

[PlayerController.cs]



n VAR2020-unity-roll-a-ball - roll-a-ball - PC, Mac & Linux Standalone -

U I ) Cou nt text File Edit Assets GameObject Component Tutorial Window Helj
' (2 .

%= Hierarchy
+ v [ All
Create Empty
e Create Ul Create Empty Child
3D Object >
i >
 Select Text - TextMeshPro e ,
Light >
Audio >
Video >
Ul > Text
Volume > Text - TextMeshPro
Camera Image
Raw Image
Button
Button - TextMeshPro
Toggle
Slider
Scrollbar
Dropdown
Dropdown - TextMeshPro
Input Field
Input Field - TextMeshPro
Canvas
= Project Panel
+v Scroll View

v  Favorites

Event System
Y AllRdatarials




Shift + Alt and select upper left >

change the anchor of Ul

Tutorial Window Help
Toona| Booa D Soatan- ) &
a®Game | O Inspector | &l

# Scene | fij Asset Store - : : N —
s?éo\ﬁ?iv ¥ Wt~ Gizmos | v| o |Display 1 v Free Aspect ¥ | Scale @— 1x @ vl CountText " Static v

Shaded v o |[ew | =
COUﬂt TEXt = Tag Untagged v Layer Ul v

\ e Rect Transform o

40 - Al
“-!E:ount Text &

o o = left
@ v| CountText Static v |:)°S X l:)os Y I:)os 7
A
v | v Q - =
Tag Untagged Layer U 8 |:| I Height
¥ :%  Rect Transform e i LTVl £n PR
> Anchor Presets
o Pos X Pos Y Pos Z Shift: Also set pivot  Alt: Also set position
a I:I [10 ]['10 ] 0 left center right stretch
2 Width Height .
200 50 ii| R EI [] D EI ZO0
» Anchors Z1
Pivot X0 Y1 v e
Rotation X 0 Y 0 Zo g [ O (@) (O =
Scale X 1 Y 1 Z1 ~
Y| |2 3
¥ @  Canvas Renderer o i é = D E] D E
Cull Transparent Mesh =
o
v |T| v TextMeshPro - Text (Ul) @ i § O [ [ ] =
Text -
Count Text .g m m I:] m @
%
Main Settinas
Fnable RTL Editor .



v WinText | St
ag Untagged v layeruwt v

Ul Win text

 Create another TMP text

 Anchor to the center

« Change text

[FlLiberationSans SDF (TMP_FontAsse ®
LiberationSans SDF Material v
| U S ab | AB | SC




back to PlayerController.cs

ererence
1 ] namespace: u51ng TMP r\o; and 7 1 f, 1c TextMeshProUGUI countText;
Z rererences
GameObject winTextObject;

global variables

0 references

2. Reset count and disable WinText o] SERED

IT
L

. . . rb = this.GetComponent<Rigidbody>();
In the beginning. count = 0;

SetCountText();

3_ A funCtK)n the update the winTextObject.SetActive(false);

CountText. r—
E; void SetCountText()

countText.text = "Count: " + count.ToString();
if (count >= 30)
{

winTextObject.SetActive(true);
1
J




back to PlayerController.cs void Start()

references

Update()

4. When Player hits a pick-up,

0 references

OnMove (InputValue movementValue)

Increase the count and update

references

the CountText priva id FixedUpdate()

0 references

OnTriggerEnter(Collider other)
if (other.gameObject.CompareTag(“pickups™))
etActive(false);

SetCountText();

SetCountText ()




In the scene

* Drag texts to the references of

PlayerController

None

Discrete

v
v
v

63 VAR2020- unity-roll-a-ball (InputAc' ©

<Any> v

Player
None (Input System Ul Input Module)
None (Camera)

Send Messages

v < roll-a-ball*

kedDevicel it nTrackedDeviceOri

Open Input Settings Open Input Debugger
0 Playe! ' |

ICountText (TextMeshProUGUI) ®
DWinText

hader Universal Render Pipeline/Lit v




Wall Directional Light
Transform Transform

Child: Wall * 4 Light

Pick-up (prefab)
Transform
Renderer
Collider
Rigidbody
[Rotator.cs]

RectTransform

TextMeshPro Q Ground
_ Player Transform
Main Camera Transform Rend_erer
Transform Renderer Collider
. Cgmetfa" | Collider
ameraController.cs Rigidbody
Playerlnput

[PlayerController.cs]



Edit > Project Setting > Player

£ Project Settings i AX
Q
Audio Player R
Editor - .
Graphics L W
Input Manager Settings for PC, Mac & Linux Standalone
Input System Package
Physics > lcon
| Physics 2D
Player ¥ Resolution and Presentation
Preset Manager Resolution
Quality : Fullscreen Mode (Windowed v]
Script Execution Order Default Screen Width 1024
It Tags and Layers )
¥ TextMesh Pro Default Screen Height 768
It Settings Mac Retina Support v
E Time Run In Background* .
i Ch lution t
XR Plugin Management Standalone Player Options a n g e re SO u I O n O

Capture Single Screen

Use Player Log 1 024 X 768
Resizable Window

Visible In Background v
Allow Fullscreen Switch v
Force Single Instance

Use DXGI Flip Model Swapchain for D3D11 v
b Supported Aspect Ratios

1 * Shared setting between multiple platforms. v




. Build Settings n

¢ Scenes In Build

Template/Scenes/SampleScene
v Scenes/roll-a-ball 0

Add your roll-a-ball scene

Add Open Scenes

Platform
[] Pc, Mac & Linux Standalone
(D:) > unity-projects > builds v O L Search bui
~ Windows v
Name Date modified Type Size x86_64 v
VAR2020-unity-roll-a-ball_BackUpThisFol.. 9/22/2020 17:54 File folder
VAR2020-unity-roll-a-ball_Data 9/22/2020 17:54 File folder !
) GameAssembly.dll 9/22/2020 17:54 Application extens... 14,548 KB
UnityCrashHandler64.exe 7/6/2020 19:30 Application 1,069 KB
[] UnityPlayer.dll 7/6/2020 19:30 Application extens... 25,283 KB
Q VAR2020-unity-roll-a-ball.exe 7/6/2020 19:29 Application 636 KB

HTYML

WebGL Compression .
g Build !

Player Settings... Build Build And Run

It v

bout Unity Cloud Build




Expected outcome

* A minimal roll-a-ball game.



References

https://gamedevbeginner.com/how-to-move-objects-in-unity/
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